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1 Introduction
1 Introduction

1.1 Target group

This documentation is aimed at users with the following knowledge and skills:

 Knowledge of the robot controller system

 Basic knowledge of the Windows operating system

 Basic knowledge of network technology

1.2 Industrial robot documentation

The industrial robot documentation consists of the following parts:

 Documentation for the manipulator

 Documentation for the robot controller

 Operating and programming instructions for the KUKA System Software

 Documentation relating to options and accessories

 Parts catalog on storage medium

Each of these sets of instructions is a separate document.

1.3 Representation of warnings and notes

Safety These warnings are relevant to safety and must be observed.

This warning draws attention to procedures which serve to prevent or remedy 
emergencies or malfunctions: 

Notes These hints serve to make your work easier or contain references to further 
information.

For optimal use of our products, we recommend that our customers 
take part in a course of training at KUKA College. Information about 
the training program can be found at www.kuka.com or can be ob-

tained directly from our subsidiaries.

These warnings mean that it is certain or highly probable 
that death or severe injuries will occur, if no precautions 

are taken.

These warnings mean that death or severe injuries may 
occur, if no precautions are taken.

These warnings mean that minor injuries may occur, if 
no precautions are taken.

These warnings mean that damage to property may oc-
cur, if no precautions are taken.

These warnings contain references to safety-relevant information or 
general safety measures. 
These warnings do not refer to individual hazards or individual pre-

cautionary measures.

Procedures marked with this warning must be followed 
exactly.
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1.4 Terms used

1.5 Trademarks

Windows is a trademark of Microsoft Corporation.

Tip to make your work easier or reference to further information.

Term Description

KUKA smartHMI User interface of the KUKA System Software 
(KUKA smart Human-Machine Interface)

KUKA smartPAD Teach pendant for the industrial robot

KRL KUKA Robot Language

KLI KUKA Line Interface. Connection to higher-level 
control infrastructure (PLC, archiving)

KSS KUKA System Software

VSS VW System Software

VRP Virtual Remote Pendant
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2 Product description
2 Product description

KUKA.VirtualRemotePendant is a virtual KUKA smartPad which can be used 
to access any robot controller that has a network connection via the KLI.

Functions KUKA.VirtualRemotePendant has the same functions as a real KUKA smart-
Pad. Jogging the robot does not require enabling with the enabling switch, 
however.

Constraints  If the robot controller is operated in T1, T2 or AUT mode before the VRP 
is connected, the robot cannot be operated with the VRP. AUT mode is not 
relevant for the VSS.

 It is not possible to switch to CRR (Controlled Robot Retraction) mode.

 The test operating modes T1 and T2 that can be selected using the VRP 
do not correspond to the operating modes in the standard EN ISO 10218-
1, but are equivalent in terms of the safety level.

 It is not possible to archive data from robot controllers to the PC/laptop on 
which KUKA.VirtualRemotePendant is installed.

The following operating sequences are only possible with the safety gate 
closed and acknowledged:

 Moving the robot (manually or under program control)

 Manual manipulation of digital or analog outputs
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3 Safety
3 Safety

This documentation contains safety instructions which refer specifically to the 
software described here. 

The fundamental safety information for the industrial robot can be found in the 
“Safety” chapter of the Operating and Programming Instructions for System In-
tegrators or the Operating and Programming Instructions for End Users.

The “Safety” chapter in the operating and programming instructions 
must be observed. Death to persons, severe injuries or considerable 
damage to property may otherwise result.

The safety measures for the KUKA smartPad, described 
in the “Safety” chapter of the Operating and Program-

ming Instructions, also apply for KUKA.VirtualRemotePendant and must be 
observed accordingly. Death to persons, severe injuries or considerable 
damage to property may otherwise result.
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4 Planning
4 Planning

4.1 EMERGENCY STOP device

The system integrator is responsible for ensuring that an EMERGENCY STOP 
device is installed at each remote operating station. This EMERGENCY STOP 
device must act on the EMERGENCY STOP circuits whose robots and robot 
systems can be operated from the respective remote operating stations. A re-
mote operating station is a laptop or PC on which KUKA.VirtualRemotePen-
dant is installed and which is connected to robot controllers via KLI.
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5 Installation
5 Installation 

5.1 System requirements

Robot controller Hardware:

 KR C4

Software:

 KUKA System Software 8.2

 Or VW System Software 8.2

Laptop/PC  Windows XP (32-bit) or Windows 7 (32-bit / 64-bit)

 Graphics card with a resolution of at least 1024 x 768 pixels

5.2 Installing KUKA.VirtualRemotePendant

Precondition  Local administrator rights

Procedure 1. Start the program Setup.exe from the CD-ROM.

2. Select the desired language and click on Next >.

3. The installation wizard opens. Click on Next >.

4. Accept the license agreement and click on Next >.

5. Read and accept the safety instruction and click on Next >.

6. Select the directory and click on Next >.

7. Click on Install. KUKA.VirtualRemotePendant is installed.

8. Once installation is completed, click on Finish to close the installation wiz-
ard.

KUKA.VirtualRemotePendant must not be installed on a robot con-
troller, Office PC or OfficeLite virtual machine.
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6 Graphical user interface
6 Graphical user interface

6.1 KUKA.VirtualRemotePendant user interface

The KUKA.VirtualRemotePendant user interface largely corresponds to the 
KUKA smartHMI. Only those parts of the user interface that are specific to KU-
KA.VirtualRemotePendant are described here.

If a touch screen is used, the user interface can also be operated with a finger 
or stylus.

Information about KUKA smartHMI is contained in the documentation 
of the KUKA System Software or VW System Software.

Fig. 6-1: KUKA.VirtualRemotePendant user interface

1 Session Manager 2 Virtual KUKA smartPad

Fig. 6-2: Session Manager

Item Description

1 Group

2 On button

3 Robot name or IP address
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4 Connect button

5 Status indicator (corresponds to the display on the KUKA 
smartHMI)

Button Description

The VRP is connected to the controller.

The VRP is establishing a connection to the controller.

An error occurred while establishing a connection.

A KUKA smartPad is connected to the controller.

The controller is switched off or cannot be accessed.

No KUKA smartPad is connected to the controller. The VRP 
can be connected to the controller.

The controller is switched off or cannot be accessed.

The controller has been shut down, but not switched off at the 
main switch. The button can be used to switch the controller 
on.

The controller is switched on or cannot be accessed.

Item Description
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7 Operation
7 Operation

7.1 Starting VirtualRemotePendant

Procedure 1. Double-click on the KUKA Virtual Remote Pendant icon on the desktop.

2. The first time the program is started, the Select controllers window is 
opened. One or more controllers must be selected here.

 (>>> 7.2 "Selecting a controller" Page 17)

7.2 Selecting a controller

Precondition  Robot controllers are connected to the company network via KLI.

 Laptop or PC is connected to the desired robot controller via the network.

Procedure 1. Select the menu sequence Edit > Select controllers. The Select Devic-
es window is opened.

All controllers present in the network are automatically displayed in the 
Discovery tab.

2. To display suitable controllers only, activate the Show only suitable de-
vices check box. A suitable controller is one on which KSS 8.2 or VSS 8.2 
is installed.

3. Select the desired controller and click on the Right arrow button.

4. The selected controller is displayed in the right-hand window. Click on OK.

The controller is displayed in the Session Manager.

7.2.1 Selecting a controller with manual entry

Procedure 1. Select the menu sequence Edit > Select controllers. The Select con-
trollers window is opened.

2. On the Manual entry tab, enter the IP address or name of the controller in 
the input box.

3. Click on the Right arrow button.

4. The selected controller is displayed in the right-hand window. Click on OK.

The controller is displayed in the Session Manager.

Fig. 7-1: “Select controllers” window
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7.3 Creating and deleting groups

For the purposes of clarity, or to view all the robot controllers in a cell at a 
glance, groups can be created.

Procedure 1. Select the menu sequence Edit > Select controllers. The Select con-
trollers window is opened.

Group A is already created by default.

2. Click on New group.

A new tab is created in the right-hand window. A maximum of 5 groups can 
be created.

3. The order of the controllers in the group can be changed by means of 
Drag&Drop or using the Arrow up and Arrow down buttons.

4. To delete a group, select the group and click on Delete group.

7.4 Connecting VirtualRemotePendant to a controller

Precondition  The robot controller is switched on and accessible via the network.

 The robot controller is selected and is displayed in the Session Manager.

 Safety gate is closed.

 AUT EXT mode

Procedure 1. Click on the Connect button.

2. To terminate the connection, click on the Connect button again or exit Vir-
tualRemotePendant.

7.5 Exiting VirtualRemotePendant

Procedure  Select the menu sequence File > Exit.

If the VRP is connected to a controller, the connection is terminated.

In T1, T2 and AUT modes, a connection is only possible if no KUKA 
smartPad has logged onto the robot controller. The robot cannot be 
moved in these operating modes. Operator actions that do not require 

motion enabling can be executed, however. AUT mode is not relevant for the 
VSS.

If the robot controller is in T1, T2 or AUT mode and VirtualRemote-
Pendant is exited, the PLC can no longer control the robot. It is advis-
able to switch to AUT EXT mode before exiting 

VirtualRemotePendant. AUT mode is not relevant for the VSS.
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8 Troubleshooting

8.1 Outputting the LOG file

Information about the status of the application and any errors that have oc-
curred is saved in the LOG file of KUKA.VirtualRemotePendant. In the case of 
an error, the user can send the LOG file to KUKA Service.

Procedure 1. Select the menu sequence ? > Error treatment.

2. Select the directory and click on Save.

If the application no longer responds, the file VirtualRemotePendant.log can 
be copied from the directory %APPDATA%\KUKA\VRP.

Fault Reason Remedy

The robot cannot be moved 
although the safety gate is 
closed and acknowledged.

Before the connection to the 
VRP was established, the 
robot controller was in T1, T2 
or AUT mode. AUT mode is 
not relevant for the VSS.

1. Terminate VRP connec-
tion

2. Set the operating mode to 
AUT EXT on the robot con-
troller.

3. Re-establish the VRP con-
nection.

After VRP has been exited, 
the robot can no longer be 
controlled by the PLC. The fol-
lowing message is displayed:

“Virtual KCP was not discon-
nected in EXT mode.”

Before VRP was exited, the 
operating mode was set to T1, 
T2 or AUT. AUT mode is not 
relevant for the VSS.

1. Connect VRP or KUKA 
smartPad to the robot con-
troller.

2. Acknowledge the mes-
sage.

3. Set the operating mode to 
AUT EXT.

VRP connection was termi-
nated automatically.

A KUKA smartPad was con-
nected to the robot controller.

 The controller is in AUT 
EXT mode: re-establish 
the connection.

 The controller is in a differ-
ent operating mode: re-
connection is not possible 
as long as the KUKA 
smartPad is connected.

A different VRP has been con-
nected to the robot controller.

Re-establish the connection.

The maximum number of con-
nections has been exceeded; 
the connection was the oldest 
connection.

Re-establish the connection.

Note: If the maximum num-
ber of connections is 
exceeded again by the re-
established connection, the 
oldest connection is termi-
nated.

The robot controller has been 
switched off.

Switch the robot controller 
back on.
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9 KUKA Service
9 KUKA Service

9.1 Requesting support

Introduction The KUKA Roboter GmbH documentation offers information on operation and 
provides assistance with troubleshooting. For further assistance, please con-
tact your local KUKA subsidiary.

Information The following information is required for processing a support request:

 Model and serial number of the robot

 Model and serial number of the controller

 Model and serial number of the linear unit (if applicable)

 Model and serial number of the energy supply system (if applicable)

 Version of the KUKA System Software

 Optional software or modifications

 Archive of the software

For KUKA System Software V8: instead of a conventional archive, gener-
ate the special data package for fault analysis (via KrcDiag).

 Application used

 Any external axes used

 Description of the problem, duration and frequency of the fault

9.2 KUKA Customer Support

Availability KUKA Customer Support is available in many countries. Please do not hesi-
tate to contact us if you have any questions.

Argentina Ruben Costantini S.A. (Agency)

Luis Angel Huergo 13 20

Parque Industrial

2400 San Francisco (CBA)

Argentina

Tel. +54 3564 421033

Fax +54 3564 428877

ventas@costantini-sa.com

Australia Headland Machinery Pty. Ltd.

Victoria (Head Office & Showroom)

95 Highbury Road 

Burwood

Victoria 31 25

Australia

Tel. +61 3 9244-3500

Fax +61 3 9244-3501

vic@headland.com.au

www.headland.com.au
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Belgium KUKA Automatisering + Robots N.V.

Centrum Zuid 1031

3530 Houthalen

Belgium

Tel. +32 11 516160

Fax +32 11 526794

info@kuka.be

www.kuka.be

Brazil KUKA Roboter do Brasil Ltda.

Travessa Claudio Armando, nº 171

Bloco 5 - Galpões 51/52

Bairro Assunção

CEP 09861-7630 São Bernardo do Campo - SP

Brazil

Tel. +55 11 4942-8299

Fax +55 11 2201-7883

info@kuka-roboter.com.br

www.kuka-roboter.com.br

Chile Robotec S.A. (Agency)

Santiago de Chile

Chile

Tel. +56 2 331-5951

Fax +56 2 331-5952

robotec@robotec.cl

www.robotec.cl

China KUKA Robotics China Co.,Ltd.

Songjiang Industrial Zone

No. 388 Minshen Road

201612 Shanghai

China

Tel. +86 21 6787-1888

Fax +86 21 6787-1803

www.kuka-robotics.cn

Germany KUKA Roboter GmbH

Zugspitzstr. 140

86165 Augsburg

Germany

Tel. +49 821 797-4000

Fax +49 821 797-1616

info@kuka-roboter.de

www.kuka-roboter.de
Issued: 23.04.2013 Version: KUKA.VirtualRemotePendant 1.0 V3 en (PDF)



9 KUKA Service
France KUKA Automatisme + Robotique SAS

Techvallée

6, Avenue du Parc

91140 Villebon S/Yvette

France

Tel. +33 1 6931660-0

Fax +33 1 6931660-1

commercial@kuka.fr

www.kuka.fr

India KUKA Robotics India Pvt. Ltd.

Office Number-7, German Centre,

Level 12, Building No. - 9B

DLF Cyber City Phase III

122 002 Gurgaon

Haryana

India

Tel. +91 124 4635774

Fax +91 124 4635773

info@kuka.in

www.kuka.in

Italy KUKA Roboter Italia S.p.A.

Via Pavia 9/a - int.6

10098 Rivoli (TO)

Italy

Tel. +39 011 959-5013

Fax +39 011 959-5141

kuka@kuka.it

www.kuka.it

Japan KUKA Robotics Japan K.K.

YBP Technical Center

134 Godo-cho, Hodogaya-ku

Yokohama, Kanagawa

240 0005

Japan

Tel. +81 45 744 7691

Fax +81 45 744 7696

info@kuka.co.jp

Canada KUKA Robotics Canada Ltd.

6710 Maritz Drive - Unit 4

Mississauga

L5W 0A1 

Ontario

Canada

Tel. +1 905 670-8600

Fax +1 905 670-8604

info@kukarobotics.com

www.kuka-robotics.com/canada
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Korea KUKA Robotics Korea Co. Ltd.

RIT Center 306, Gyeonggi Technopark

1271-11 Sa 3-dong, Sangnok-gu

Ansan City, Gyeonggi Do

426-901

Korea

Tel. +82 31 501-1451

Fax +82 31 501-1461

info@kukakorea.com

Malaysia KUKA Robot Automation Sdn Bhd

South East Asia Regional Office

No. 24, Jalan TPP 1/10

Taman Industri Puchong

47100 Puchong

Selangor

Malaysia

Tel. +60 3 8061-0613 or -0614

Fax +60 3 8061-7386

info@kuka.com.my

Mexico KUKA de México S. de R.L. de C.V.

Progreso #8

Col. Centro Industrial Puente de Vigas

Tlalnepantla de Baz

54020 Estado de México

Mexico

Tel. +52 55 5203-8407

Fax +52 55 5203-8148

info@kuka.com.mx

www.kuka-robotics.com/mexico

Norway KUKA Sveiseanlegg + Roboter

Sentrumsvegen 5

2867 Hov

Norway

Tel. +47 61 18 91 30

Fax +47 61 18 62 00

info@kuka.no

Austria KUKA Roboter Austria GmbH

Vertriebsbüro Österreich

Regensburger Strasse 9/1

4020 Linz

Austria

Tel. +43 732 784752

Fax +43 732 793880

office@kuka-roboter.at

www.kuka-roboter.at
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Poland KUKA Roboter Austria GmbH

Spółka z ograniczoną odpowiedzialnością

Oddział w Polsce

Ul. Porcelanowa 10

40-246 Katowice

Poland

Tel. +48 327 30 32 13 or -14

Fax +48 327 30 32 26

ServicePL@kuka-roboter.de

Portugal KUKA Sistemas de Automatización S.A.

Rua do Alto da Guerra n° 50

Armazém 04

2910 011 Setúbal

Portugal

Tel. +351 265 729780

Fax +351 265 729782

kuka@mail.telepac.pt

Russia OOO KUKA Robotics Rus

Webnaja ul. 8A

107143 Moskau

Russia

Tel. +7 495 781-31-20

Fax +7 495 781-31-19

kuka-robotics.ru

Sweden KUKA Svetsanläggningar + Robotar AB

A. Odhners gata 15

421 30 Västra Frölunda

Sweden

Tel. +46 31 7266-200

Fax +46 31 7266-201

info@kuka.se

Switzerland KUKA Roboter Schweiz AG

Industriestr. 9

5432 Neuenhof

Switzerland

Tel. +41 44 74490-90

Fax +41 44 74490-91

info@kuka-roboter.ch

www.kuka-roboter.ch
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Spain KUKA Robots IBÉRICA, S.A.

Pol. Industrial

Torrent de la Pastera

Carrer del Bages s/n

08800 Vilanova i la Geltrú (Barcelona)

Spain

Tel. +34 93 8142-353

Fax +34 93 8142-950

Comercial@kuka-e.com

www.kuka-e.com

South Africa Jendamark Automation LTD (Agency)

76a York Road

North End

6000 Port Elizabeth

South Africa

Tel. +27 41 391 4700

Fax +27 41 373 3869

www.jendamark.co.za

Taiwan KUKA Robot Automation Taiwan Co., Ltd.

No. 249 Pujong Road

Jungli City, Taoyuan County 320

Taiwan, R. O. C.

Tel. +886 3 4331988

Fax +886 3 4331948

info@kuka.com.tw

www.kuka.com.tw

Thailand KUKA Robot Automation (M)SdnBhd

Thailand Office

c/o Maccall System Co. Ltd.

49/9-10 Soi Kingkaew 30 Kingkaew Road

Tt. Rachatheva, A. Bangpli

Samutprakarn

10540 Thailand

Tel. +66 2 7502737

Fax +66 2 6612355

atika@ji-net.com

www.kuka-roboter.de

Czech Republic KUKA Roboter Austria GmbH

Organisation Tschechien und Slowakei

Sezemická 2757/2

193 00 Praha

Horní Počernice

Czech Republic

Tel. +420 22 62 12 27 2

Fax +420 22 62 12 27 0

support@kuka.cz
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Hungary KUKA Robotics Hungaria Kft.

Fö út 140

2335 Taksony

Hungary

Tel. +36 24 501609

Fax +36 24 477031

info@kuka-robotics.hu

USA KUKA Robotics Corporation

51870 Shelby Parkway

Shelby Township

48315-1787 

Michigan

USA

Tel. +1 866 873-5852

Fax +1 866 329-5852

info@kukarobotics.com

www.kukarobotics.com

UK KUKA Automation + Robotics

Hereward Rise

Halesowen

B62 8AN

UK

Tel. +44 121 585-0800

Fax +44 121 585-0900

sales@kuka.co.uk
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